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FILTERING AND DISPLAYING  
DATA USING AJAX 

By Bob Flynn, Indiana University 

This document is an update to chapter 9 of Adobe Dreamweaver CS3 with ASP, ColdFusion, and PHP: Training from the 
Source from Adobe Press. It has been updated to accommodate the changes in the Spry functionality in Dreamweaver 
CS4. 

One of the many benefits of using databases is that they are scalable. At the moment, the Newland Tours database 
contains profiles for 16 countries. However, over time the business could grow, and contain profiles of 40 or even 60 
countries. But even at 16, the complete listing of country profiles on a single Web page is too much for most users to 
wade through. Users aren’t usually interested in all the countries, but rather a subset—the ones they are considering 
visiting. The same applies to the tour descriptions themselves and even more broadly to most database data on the Web. 
Imagine using Amazon if you had to download and display millions of products on a single page! 

For this reason, it is important when developing dynamic Web sites to make it easy to filter data, so that users can see the 
data that they want to see. You can enable your site’s visitors to filter data in many different ways, from simple URL 
parameters to full-blown search engines.  

In this lesson, you will learn to use a technique called Ajax, to create a richer, more engaging experience for your users. 
The users will be able to see the detailed profiles of the countries chosen without moving to another page or reloading the 
current page, making the user experience seem faster and the page seem more responsive.  

Although there are many different ways to create Ajax functionality, Adobe has designed an easy-to-use Ajax library, 
called Adobe Spry. In Dreamweaver CS3, Adobe built in Spry functionality and included a number of user interface 
elements. We’ll therefore use Spry to create our Ajax functionality. In Dreamweaver CS4, Adobe expanded the Spry 
functionality, giving more options for pulling in data and a few very useful tools for developing with Spry. 

In this exercise you will build a list of country names that will link to their 
individual profiles. The advantage to this approach is that once you’ve built 
the application, maintaining it is as simple as updating the data itself—no 
need to revise either page if a country is added, removed, or renamed (it 
happens). 

The profile of each country is pulled from an XML structure dynamically built 

from the database and formatted on the fly using Adobe Spry and CSS. 
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What You Will Learn 

In this class, you will: 

• Setting up a site in Dreamweaver 

• Learn about an alternative for passing data to Web pages 

• Create an application that filters and displays database data using Adobe Spry 

• Create dynamic Spry data regions 

• Display images dynamically 

• Layout multiple elements populated with dynamic data and style them with custom CSS 

Defining a Static Site 

The Newland Tours site, as you are inheriting it, is a static HTML site. For this reason, you can easily pull it into Dreamweaver and 

start working on it. 

Working with Web sites often involves hundreds or even thousands of individual files, including Web pages, images, cascading style 

sheets, multimedia assets, and more. These files are linked together via HTML. Unfortunately, a small typo can create ugly (or 

indecipherable to users) error messages and even block access to portions of your site. Dreamweaver provides many sophisticated site 

management tools to help ensure the overall integrity of your site, both during development and once it is launched. To take advantage 

of these features, you should first define a site, a process in which, at a minimum, you tell Dreamweaver where the site’s root folder is 

located on your hard drive. 

Defining a site has several benefits, many of which you will see quickly. It helps prevent broken links, automatically updating files 

site-wide if you move or rename a file. The Site Manager also enables you to perform site-wide operations, such as Find and Replace, 

which greatly boosts productivity. Another key advantage of the Site Manager is that it has built-in file uploading capabilities 

(including FTP), which means you can publish your files to the Web whenever you want, with the click of a single button. You can 

even synchronize local files (on your hard drive) and remote files (on the Web or a staging server), to ensure that the most up-to-date 

versions of the files are in the right place. 

In this task, you’ll define a regular, static site in the Site Definition dialog box, a process involving little more than giving the site a 

name and telling Dreamweaver where it is stored on the local disk.  

1. Create a new directory on your hard disk called dwcs4. 

You’ll store the local version of the site in this folder. 

2. Copy the newland folder (and its contents) into this new directory. 

Often enough in real life, you’ll inherit an existing site and be asked to upgrade it. With any significant upgrade, it’s best to make a 

copy of the existing site and work on that. You should never directly edit a site in production (that is, the site that the public sees). 

3. Open Dreamweaver CS4. 

Once the files are visible in Dreamweaver, you should edit them exclusively in Dreamweaver. Any text editor can open any HTML 

file, and every operating system has a file management utility (such as Macintosh Finder or Windows Explorer) that lets you move 

and delete files. But you should avoid using these tools, because any change is likely to foil Dreamweaver’s Site Manager, and could 

cause broken links. So once the files are there, go straight to Dreamweaver and avoid the temptation to do anything to them by any 

other means. 

4. On the Start page, click the Create New Dreamweaver Site link. 

Note: You can also choose Site > Manage Sites and click the New button. 

Though the files are on your hard disk, Dreamweaver doesn’t yet see them. By defining a site, you enable Dreamweaver to see—and 

manage—the files. You define a site in the Site Definition dialog box. If the dialog you see doesn’t look like the one in the screen 

shot, it’s probably because you are in advanced view. Click the Basic tab near the top of the dialog to bring up the basic view shown in 

the screen shot. 
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5. Enter Newland Tours in answer to the question “What would you like to name your site?”, and click Next. There is no 
need to fill in the “HTTP Address” of the site at this time. 

The Site Definition dialog’s basic view uses a wizard-like approach. 

Tip: If you prefer the old-style Site Definition dialog better, you can access it by clicking the Advanced tab. 

6. On the Editing Files, Part 2 screen, select “No, I do not want to use a server technology.” Click Next. 

 

7. On the next screen, select the first option,“Edit local copies on my machine, then upload to server when ready 
(recommended).” 

As a result of this decision, there will always be two sets of files for the site—one local (usually on your hard drive, though you can 

put it in a network folder if you want) and one remote (usually on a server). This is safer, because you always have at least one backup 

copy of your file. More importantly, it means that the files you work on will be stored on your hard drive, where customers will never 

see them. 

Most professional sites work using a 3-tier setup. The local site contains all the files in development on the Dreamweaver user’s hard 

drive. A staging server contains a mirror of the site used for testing and development purposes only. The public never sees content on 

the staging server, but it is a real Web server environment, which is typically identical or nearly identical to that of the production 

server. The production server is the public version of the site. Only tested, edited, polished, and approved files should be published on 

the production server. 

8. Click the folder icon beside “Where on your computer do you want to store your files”, and browse to the newland folder 
within the dwcs4 folder. Click Select to select the folder and return to the Site Definition dialog box. Click Next. 

In this step you are defining the local site—this is where all the action takes place. Whenever you edit a file, you will be editing the 

file as it appears in the local site. The local site is generally not seen by the public, which means if you temporarily break the 

functionality of the site as you work, no harm is done. 
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9. On the next screen, choose None in the drop-down menu. 

Normally, you specify either a staging server or production server as the Remote site. When working with dynamic, database-driven 

content, a staging server is a necessity. 

Later you would define a remote site, which you would use as a staging server. That staging server would be able to handle fully 

dynamic sites, which the local site you are defining can’t do. But for now, a remote site is an unnecessary complication. 

 

10. Click Next. Review the summary, and click Done. 

When you are finished, a dialog box appears, indicating that Dreamweaver is building the site cache. Dreamweaver is analyzing all the 

files in the site, checking all the links, and storing them in memory. If you decide to rename a page or move an asset to a different 

folder, Dreamweaver will automatically update all of the files that link to the modified file. Once Dreamweaver has built the site 

cache, the dialog disappears on its own. 

When you are finished, the Site panel (by default, in the lower-right corner of your screen) should be filled with files.  

 

Passing and Using Data with Ajax 

Ajax or “Asynchronous JavaScript and XML”, is a term that was coined in 2005 for a technique that’s been available for over a 

decade. The Ajax technique is used to pass data to and from interactive Web applications. It helps you create Web pages that appear 
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more responsive because the data passes between the user’s computer and the server behind the scenes, without requiring the page to 

reload. 

The two main technologies that make up Ajax are XML and JavaScript. Extensible Markup Language (XML) is a language that 

allows you to package information, such as a recordset, and maintain its structure while you send it over the internet. JavaScript is a 

scripting language that lets you manipulate objects, such as your recordset, in the user’s browser. Prior to Dreamweaver CS4 you had 

to use XML or JSON (JavaScript Object Notation, another way to structure your data) to provide the data for Ajax. CS4 now allows 

you to use HTML tables as recordsets. This makes Ajax much more accessible to Web developers. 

Note: There are accessibility concerns about Ajax. Some users browse with JavaScript disabled and some do not have 
JavaScript available to their browsers. These issues should be taken into consideration before deciding to use Ajax on 
your Website. There are examples of techniques for avoiding this problem in the resources section at the end of these 
materials. 

Note: JavaScript is not to be confused with Java. The former is a scripting language primarily used for Web development. 
The latter is a powerful programming language that can be used for Web development but is primarily used for 
creating computer applications. 

There are several Ajax libraries available, some with quite sophisticated capabilities. Each requires a different level of technical 

knowledge to use. Adobe created the Spry framework to make Ajax available to Web designers with minimal programming 

experience.  

The Spry framework has a number of useful elements, including a number of user interface “widgets”, visual effects and form 

validation. It is designed to be easy to implement for anyone with a basic knowledge of HTML, CSS and JavaScript.  

Dreamweaver CS4 shipped with Spry prerelease version 1.6.1. Each release includes new features and refinements. It is easy to update 

your Spry libraries. The Spry team releases a Dreamweaver Extension with each new release of Spry. 

Note: You can read more about Spry, see demos of the available functionality, and download the latest version on the 
Adobe Labs site http://labs.adobe.com/technologies/spry/. 

In this class, you will take the recordset that might be created by querying the database for the country profiles, and publish it as a 

page on the Web. We will look at XML, JSON and HTML versions of the data. While you are welcome to use whichever version you 

like, we will use the HTML version for this class as this is what most people are comfortable with. This will serve as the data for your 

profile page application. You will then use Adobe Spry to create a table for the list of countries and their regions, and use the Spry 

Accordion to display details of the chosen country. 

Before we begin, let’s take a look at the data. The newland folder has all three versions of the data. Each format has its own 

advantages and your situation will dictate which you ultimately use. If your records are maintained in a database then you may have 

experience outputting them as HTML tables already. Many programming languages have functions to output records as XML. If you 

have a many or very large records then JSON might be best because it is the lightest-weight solution. For now XML will give us the 

best view of the data, so we will start there.  

1. Open countryDetailXML.xml. Press F12 to view the results. 

Most modern browsers can parse and display properly-formed XML. The entire recordset is labeled <countries> with each 

individual record shown in an individual <country> node in the XML file. In this case the fieldnames in the XML dataset reflect the 

fieldnames from the database from which the data was pulled. While these names are arbitrary, they will be the names of your 

variables once you pull the data into your page. The browser’s parser allows us a convenient view of the data. If you click the minus (-

) sign next to an opening tag of any element that has multiple rows of content, it will collapse the element for greater ease of reading.  



   2009, Bob Flynn 6 

 

The XML view gives a clear idea of the nature of our recordset. To visualize it another way, we will look at the HTML table version. 

2. Close the XML file and open countryDetailTable.html. Press F12 to view the results. 

 

The HTML table view of the data should be comfortably familiar. Fortunately Dreamweaver CS4 and Spry give you options to use 

data in this format as well. Before closing the HTML file take a look at the opening table tag in the source code. You will see that its 

ID attribute has the value "countries". This is critical for making it available to Spry as a data source. We will return to that later. You 

may now close the HTML file. 

Finally we will look at the JSON data. While Dreamweaver CS4 does recognize JSON data through its Spry Data Set wizard, the 

functions are there in the libraries and the tag insight will suggest it when typing in code view. 

3. Open countryDetailJSON.js. 
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The browser preview (F12) command does not work with JavaScript files because they will look just the same in the browser. You 

can see the way that JSON structure works on the same data. When you are finished looking it over, close the JSON file. 

Now it is time to take our data file and use it to create a more dynamic experience for our users and our site administrators. 

Connect Country Profiles page to HTML data 

Currently, the Country Profiles page (profiles.html) contains a listing in static HTML of the countries to which Newland offers tours. 

In order to create a page that is easy to maintain when new countries are added or changed, this information should come from a 

database. We will use our data file to emulate a database. That means that just about all of the content on this page (excluding the 

banner and footer) is obsolete, so you need to delete it. 

Once you have removed all of the old content, you’ll need to add a list of links that will let users choose a country profile. This list 

will come from the HTML dataset you viewed in the previous section. In this step you will pull that dataset into this page for use by 

Spry, both for the list and the detailed profiles. 

1. Open profiles.html in design view. 

I find it much easier to delete page content while in design view, rather than hunting around for the proper start and stop points in code 

view. 

2. Drag to select everything on the page starting from the horizontal rule just above Namibia all the way down to the 
bottom of the page to just include the words Nuevo Peso at the end of the profile of Mexico. 

Be careful not to select any of the footer. 

 

3. Press Delete. 

The content is removed and the cursor is left in an empty <p> tag, visible in code or split view, at the bottom of the page. 

4. Replace the first line of body text with The following list shows all of the countries to which we currently offer tours. To 
learn more about a country, click on its name. 

Here, you are just changing the directions of the page to reflect the new functionality of the page. 
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5. Insert your cursor in the black space below the paragraph you just typed. Under the Insert menu, click Spry > Spry Data 
Set. 

 

6. In the Spry Data Set dialog window leave the Data Set Type HTML the Data Set Name ds1, and Detect Tables. Next to 
Specify Data File browse for countryDetailTable.html. Click the yellow arrow to the left of the table headings to identify this 
table as your data container. 

 

Take a moment to examine the other options in the dialog box. Note that by changing the Data Type you could use the XML file 

instead of the HTML tables. The Detect drop-down shows the other types of containers that can serve as data sources. In this example 

it is not really necessary to identify the data container as there is only one table on the page. Were there more than one source (table, 

div or list) a yellow arrow would appear next to each, allowing you to identify which container would be the source of your data.  

7. In the Data Containers drop-down choose “countries”. That value comes from the ID attribute of the table that we noted 
earlier when looking at the source code of the HTML document. Once selected the Data Preview at the bottom of the 
dialog window is populated. 
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8. Click Next to move to the Set Data Options window. Choose the population column and set its type to number. All 
others can remain strings. You also have the option of setting a default sort for the data. Choose countryName Ascending. 
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9. Click Next to move to the Choose Insert Options window. Choose Insert table and click Set Up... You will choose which 
fields in the dataset you want in your table. 

 

10. Remove all columns except region and countryName using the "-" next to Columns. Move countryName above region 
by highlighting the countryName row and clicking the up arrow. Make sure the value for Sortable is set to Yes for each 
column name. If it is not, highlight the name and click the checkbox below. Finally, check "Update detail regions when row 
is clicked". Click OK.  

The dialog window should look like the below screen shot before closing the window. 

 

11. Click Done to close the Spry Data Set wizard. Switch to code view to see what Dreamweaver has inserted in your 
page. 

You will recall that Ajax uses JavaScript to manipulate your data. In order for Spry to use the HTML file you just bound to 

profiles.html, it needs some JavaScript functionality. Dreamweaver has inserted references to a couple JavaScript libraries in your 

page and will prompt you to move them into your site when you save your document.  

A Spry region has been created with your Spry table inside of it. A Spry region is an area on a page 

that is bound to a dataset. This region is bound to our HTML dataset, referred to here as ds1, the 

variable it was assigned to when first connected to the page.  

If you look in the Bindings panel you will now see your full dataset ready for use. As with a 

recordset from a database query or columns in an HTML table, these individual variables can be 

inserted on the page in order to display their dynamic content. You will do just that later in the 

lesson.  

 

 

12. Add another sentence of instructions at the end of the text at the top of the page. Add 
Click column headings to sort. 
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You will add a visual indication that the column headings are clickable hotspots when you style the table, but some simple directions 

will also aid the users. 

5. Save the changes to your file. You will be prompted to copy files into your site directory, creating a SpryAssets folder in 
the process. Accept the files. Highlight profiles.html in your Files panel and press F12 to preview. 

You should see the list of country and region names. That was pretty easy, but what’s so special about a Spry table? The columns are 

sortable. Check the functionality by clicking the column names to sort and reverse sort the records. Without Ajax, your users would 

have to refresh the page to sort the records. 

The heading for the column with the names of the country reflects the name of the database field. Before you move on you should 

correct it by placing a blank space between Country and Name. 

 

Styling the Spry Table 

The table you created is more functional than your average table, but it could certainly be more attractive. You could give it a border 

and maybe even a background color. What about alternating the colors of the rows to make it easier for users to see distinct records? 

That sounds great, but you are building the table dynamically. How are you to color those rows on the fly? 

Spry has some built-in attributes that will not only help you color alternating rows dynamically, but add some additional effects as 

well. While you can build the custom styles using Dreamweaver’s tools as you have in previous lessons, you will have to do a little 

hand-coding to access some of these Spry features.  

1. Return to profiles.html. In the CSS panel, click the button for a new CSS rule. For Selector Type choose Class. Name 
your class .odd, for the odd-numbered rows. Click OK. Under the Background Category set a Background Color of 
#999999. 
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2. Repeat the same steps and create a class selectors named .even with a background color of #CCCCCC,  .rowHover 
with a background color of #FFFF99, and .rowSelect with a background color of #FFCC33 and a font weight of bold. Font 
weight is in the Type category. 

These classes will be applied to rows in the table dynamically by Spry, adjusting for the number of rows and reacting to the user’s 

mouse movements. 

Simply creating the custom styles does not cause them to display. They have to be tied to an element in the structure of the main 

document. You can tie them to the rows of the Spry table using Spry attributes. 

Change to either code or split view and examine the code for the Spry table. See if you can find where it binds the variables for the 

countryName and region. Spry uses curly braces {} to indicate its bindings. 

3. Place your cursor just inside the closing bracket of the <tr> tag with the spry:repeat attribute (approximately line 

42). Press the spacebar and type class="{ds_EvenOddRow}". 

Spry has some built-in variables that mask the complexity of the programming logic necessary to dynamically alternate values based 

on the row number. The ds_EvenOddRow Spry variable will change the class name to either “odd” or “even” based on the current 

table sort. The rows will then render using the classes, odd and even, that you created above. 
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4. Save your changes to both profiles.html and main.css. Select profiles.html from your file list and press F12 to view the 
changes in your browser. 

 

Spry has applied your odd and even classes to the rows. If you re-sort the columns the colors will dynamically change. But what of the 

other classes you created? How does Spry call the .rowHover and .rowSelect to affect the display?  

As you look at the code you can see a pattern with how Spry affects the HTML display. Spry code usually starts with spry: followed 

by a specific function or attribute. You will use two more of these attributes which package some complex functionality in very little 

code.  

5. Return to the <tr> tag you modified in step 3. Place your cursor just inside the closing bracket. Press the spacebar 

and type spry:hover. Note that Dreamweaver will start to present available options as you type. After typing 

spry:hover you will be presented with a list of class names from your stylesheet. Choose rowHover. 

6. Repeat the steps again, this time typing spry:select. For the value choose rowSelect. 

The finished line of code should look like the screenshot below: 

 

The Spry functions that you just added will cause the value of the class for each row to change dynamically as you mouse over or 

select a row. Dreamweaver CS4 has added a powerful new tool for both previewing the results of your changes but also viewing the 

changes with your code as you interact with it.  

7. Click the Live View button to the right of the Code/Split/Design view buttons. The design window will show a fully-functional 

preview of the changes.   
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Roll your mouse up and down over the rows. Click to select a row. The classes you created are being applied and you wrote 

remarkably little code. 

8. Now click the Live Code button to the right of the Live View button and once again mouse over the rows. 

The Live Code view displays the dynamically changing HTML code as you mouse over or select a row. Resort the rows and observe 

the changes in classes as well as the complete reordering of the rows in the code. When you are finished observing these functionality, 

click Live Code and Live View again to deactivate them. 

There is one more subtle change worth making to improve the user’s experience. Notice that when you mouse over the table headings 

your cursor remains an I-bar. If the cursor were a pointer, users would have a better visual cue indicating that the headings were 

clickable hotspots. You can change that behavior with CSS. 

8. Return to profiles.html. Create a new CSS rule. For Selector Type choose Class. Name it .sortHead. Make sure Rule 
Definition points to main.css. Click OK. Under the Block Category set Text align to center. Under the Extensions Category 
look for Cursor. In the box next to it type pointer. Click OK. 

There are many different values for the cursor, some with more support than others. I don’t know why Adobe didn’t include pointer in 

the drop-down list, but you can type in your value and Dreamweaver writes the appropriate code. 

 

9. In design view, use the tag selector to choose the <th> tag for the cell containing the Country Name heading. Using 
the property inspector, apply your newly created class sortHead to the table heading.  
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10. Repeat the previous step for the table heading containing the word Region. Save your file. View the changes in Live 
View. 

Now when you mouse over the table headings your cursor changes to a pointer, indicating to the users that there is active functionality 

in those spots. 

Creating Spry Regions 

You have only just begun to tap the power of Spry. It was easy to make a table with sortable columns and remarkably simple to style 

the table and add some rollover functionality. Clicking on the rows in your Spry table can also act as a triggering event for other 

elements on the page. Rather than send users off to another page to view the details of the selected country or even back to the server 

for more information, you can use Spry to display the relevant information on this page in a quick, compact and visually pleasing way.  

The table row that you modified in the previous section had a Spry attribute that might not have been entirely self-evident. 

spry:setrow="ds1" indicates that when a row is selected it will set any detail regions with a value of ds1 to be on the same row of 

data as the one selected. A detail region is a Spry area that displays the values for bound variables specific to the record selected in the 

main Spry region. We’ll start with a simple example of this relationship between the selected row of the table and other data on the 

page. 

1. Return to profiles.html. Place your cursor after the closing </div> tag that follows the 

closing </table> tag. Press Enter/Return once to make space and enter the following code: 

<p spry:detailregion="ds1">Record {ds_RowNumberPlus1} of 

{ds_RowCount}</p> 

This code creates a paragraph that acts as a Spry detail region. Any Spry variables inside the paragraph 

respond when the user selects an element in the Spry region. ds_RowNumberPlus1 will display the 

currently selected row number and ds_RowCount displays the total number of rows in the dataset. 

Note: ds_RowNumberPlus1 represents an offset of one from the selected row. This is because 
JavaScript, like many computer languages, begins labeling records with zero, much like the 
coordinates on a map or graph start at zero. Since we are counting we add one to the 
JavaScript label to display the current row number. 

2. Save your changes. Press Live View to see your changes. 

As you select the various rows in the table, the detail region is updated. Even when you re-sort the table 

the detail region responds to the selected item’s new position in the table and adjusts accordingly. 

 

Displaying with a Spry Accordion 

The country list has been built and you have tested its ability to take user input and change a detail region. Now you need to create a 

detail region that will display all the details of the country the user chooses. 

In order to keep the design compact you can use the area to the right of your table for your detail region. You could just output the 

variables in your dataset in a list, but Spry has a variety of user interface widgets and effects that allow you to display the data in a 

way that is more interesting for users. A Spry accordion will allow you to present the details and picture of each country in an eye-

catching way without taking up a lot of space. An accordion is a series of panels that expand and collapse to reveal the content of one 

panel while concealing the content of the other. 

1. In design view, position your cursor after the closing </p> tag of the Spry detail region you inserted in the previous 
step. Press Enter to create a space. Choose Insert > Spry > Spry Accordion. 

A two-panel accordion set has been inserted into the document. In your document code, the files that style and add functionality to the 

accordion have been referenced. Once you save your changes, copies of them will be moved to your site directory. 
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In order to make the accordion panels dynamic Spry elements, you need to identify the areas you want to be Spry detail regions. Then 

you can populate the panels with the content you want to display. You will need to work in both design and code view, so you can 

either toggle between the two or work in split view. 

2. In code view, find <div class="AccordionPanelContent">. Add spry:detailregion="ds1". Repeat the 

step for the second div. 

You can quickly find the divs by selecting the text Content 1 and Content 2 in design view. Dreamweaver’s tag insight should help 

guide you as you type.  

You have turned the accordion panels into Spry detail regions. The panels are now ready to accept Spry variables that will respond to 

the user choices in the main Spry region, your table.  

 

2. In design view, select the text “Content 1” in the first accordion panel and delete it. Type the following text into the first 
panel, pressing Enter/Return after each line. After typing each line, select the text and make it bold. 

World Region:  

Description:  

Population:  

Local Currency: 

 

3. Position your cursor at the end of the World Region: line.  

 Hit the spacebar to create a blank space, choose region in   
the bindings panel and click insert.  
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4. Repeat for each of the four elements you have labeled, choosing the appropriate variable from the bindings panel for 
each. 

 

5. Save your changes. Dreamweaver will notify you that it is moving copies of the Spry accordion files into the Spry 
Assets folder in your site directory.  

 

6. Press Live View to test the page in Dreamweaver or press F12 to preview it in your browser.  

The information in the detail region should now respond to your choices in the country table. Click around a bit to test it. Re-sort your 

table and note that the details of the selected country do not change. Click on the title bar of the second panel, labeled “Label 2” and 

test the accordion functionality. 

The accordion adds a nice effect, but you still have a lot of work to do before we can call the page complete. In the remainder of this 

class you will make a number of smaller changes to polish up the page. The second panel needs content. You will add the image 

associated with each country and its description to that panel. You will display the chosen country name more prominently on the page 

and replace the region number with its descriptive title. Finally you will make some changes to the CSS to bring the display of the 

page all together. 

Adding Images and the Country Name 

The country profile is basically functional, but you could add a little more information. In this task, you’ll add an image and a 

description of the image and display the chosen country name more prominently.  

Each tour and each country has an image, all of which are located in the images folder. An extra field in the database holds the 

image’s name and URL. To display an image, all you need to do is dynamically load its URL into an otherwise static <img> element 

in HTML. 

1. Still in profiles.html, switch to design view, mouse over the right corner of the accordion bar Label 2. An eye icon will 
appear. Click the eye to open the second panel. Select and delete the text “Content 2”. 
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In a moment, you’ll insert the image in this panel. 

2. With your cursor inside the content area of the lower accordion panel, choose Insert > Image. In the Select Image 
Source dialog, select the Data Sources radio button at the top (Windows) or the Data Sources button near the bottom 
(Macintosh). Select imageURL for the field. Insert your cursor before the opening “{“ in  the URL field at the bottom of the 
dialog and type images/.  

 

Normally, when you insert images, you browse to the image and Dreamweaver inserts the path. Because this is a dynamic image you 

are inserting, you don’t want to choose an individual image. By choosing Data Sources, you gain access to the recordset that contains 

the name of the dynamic image. You added the path to the images folder as part of the image URL to indicate the location of the 

images. 

3. When you click OK you will see the Image Tag Accessibility Attributes dialog box. Type {imageALT} for the Alternate 
text. Click OK. 
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The imageAlt field carries a description of the image. In addition to adding it to the images alt attribute we will display it on the page. 

Note: You could hard code the path to the images folder into the imageURL field in the database, obviating the need to 
add it to the URL path in this step. However, site structure sometimes changes. Should you have to rename or move 
that folder it is much easier to go back and change the path to the images in one place in the code than to have to 
update the value for the imageURL in every country record in your database. 

You will have a broken image placeholder graphic in the accordion panel. That is because you have modified the path to image. The 

important part is the dynamic image name that Spry will use when it renders the page. 

4. Insert your cursor after the image icon in the lower accordion panel. In your bindings panel select the imageAlt field and 
click Insert. 

 

5. Select the image icon and use the Property inspector to change its alignment to Right. 

When you are done with this step, the image icon appears on the right side. 

 

Before testing your changes, let’s quickly take care of a few other data display issues. The name of the country your user selects does 

not currently display anywhere other than the table. You could add it to the other data in the accordion panel, but it merits a more 

prominent place on the page. 

6. In code view, place your cursor just inside the closing bracket of the <h1> tag containing the page banner “Country 

Profiles”. This is approximately line 34. Press the spacebar and type spry:detailregion="ds1".   

 

A Spry detail region is necessary whenever you want to insert a Spry variable that you want to change based on the user selection 

from the Spry region. Now you can insert the country name. 
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7. Return to code view. Place your cursor after the word Profiles in the banner. Type a colon “:” and then a blank space. 
Next select countryName from the bindings panel and click Insert. 

 

8. Save, upload, and test the file. 

Click through the various country choices in the table. Observe how the country name changes at the top of the page. Click the second 

accordion panel to display the picture for each country. Choose another country and watch the picture and image description change. 
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Note: You did not format the population number. Ideally you would format it to display commas in the proper places but at 
the time of this writing the Spry team had not released formatting functions. Formatting functions in ASP, ColdFusion 
and PHP will not work because they do their work on the server and Spry changes the data on the user’s machine, 
after the server has completed its work. There are possible work-arounds for this issue using other languages, but 
they are beyond the scope of this class. It is likely the Spry team will provide formatting functions, including one for 
numbers, in a future release.  

Refining Page Display Using CSS Styling and 
Positioning 

The page is now fully functional and the data is accurate and complete. So your work here is done, right? Well, no, not really. 

Depending on their screen resolution, some of your users would have to scroll down after choosing a country in order to see the details 

of their selection in the accordion panel. When you choose a country with a vertical image like France, Peru or Thailand the user has 

to scroll down in the accordion panel itself to view the entire image. The information in the country table and the accordion panels is a 

bit crowded against the sides of their respective containers. The accordion panels need proper labels and perhaps most egregious of all, 

the colors of the panel tabs just don’t work with the rest of the scheme. Believe it or not, all of these are easily fixed with a little digital 

spit and polish. 

Some of these changes are dependent on one another, so the sequence in which we make them is important. In order to reduce user 

scrolling and make the best use of the available screen real estate you can move the accordion up alongside the table. But we need to 

fix the issues with the country table before you can be sure how much room you will have for the accordion, so let’s start there. 

Padding and Positioning the Country Table 

1. Return to profiles.html. In the CSS panel click the button for a new CSS rule. For Selector Type choose ID. Name it 
#countryTable and make sure Define in: is set to main.css. Under the Box Category set Width to 300 pixels, Float to left 
and uncheck the Same for all box under Margin. Add the following values – Top: 5, Right: 10, Bottom: 10 and Left: 0. All 
values are in pixels. 

You have defined a custom CSS selector. The # indicates 

that it is an ID selector. ID selectors are used for elements 

that are unique within a page. It is probably clear what 

setting its width will do, but what about the other values? 

I’ll talk about float in a moment, but how about the 

margin? The CSS Reference built into Dreamweaver 

(Shift+F1) defines margin as “... the space that extends 

beyond the border of an element to provide extra empty 

space between adjacent or nested elements…” This means 

we’ve muscled out a little white space around our table so 

that other elements do not crowd it.  

The important distinction between margin and padding, 

the other option in the Box Category, is that padding is the 

white space inside the border of the element and the 

margin is outside. That means that the 10 pixel margin you 

added to the right of the table element adds space to the 

300 pixel width, making it total 310 pixels. Had it been 10 

pixels of padding it would put those 10 pixels of white space inside your 300 pixel table element. These are two key components of 

what is referred to as the “Box Model” in CSS, the other component being the border. To see a clear demonstration of these 

differences, experiment by adding a 1 pixel border to the table so you can observe the edges of your element. Play with the margin and 

padding values and see where the space is added. Remove it when you are finished. 

Note: For years the various browsers have handled the Box Model differently. I would like to say that all browsers now 
render code in a consistent, standards-compliant way, but that is unfortunately not the case. It is difficult to make 
pixel-perfect layouts that are exactly the same in all browsers and you will see some variation in the results of your 
positioning efforts as you check the page in various browsers. 
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The other styling change you made is perhaps the most dramatic. You set float: left. That means that the element, in this case the table, 

will stick to the left side of its containing element while the rest of the page content flows around the table instead of being pushed 

down by it.  

In order to see the effects of the ID selector style you have created you must add the proper ID to the country table. 

2. In design view select the country table. If you are not sure you’ve chosen the table tag itself, click first in the table 
heading and then use the tag selector to choose the table tag. In the Properties inspector choose countryTable from the 
Table ID list. 

 

The ID countryTable was present in the list because you had already created the ID selector in the style sheet. Had you done it in the 

other order you would have been able to type countryTable into the Table ID box before creating the style. 

You have now assigned the ID to the table and the styles you created are applied in design view.  

3. Save both main.css and profiles.html then view the changes through your browser (F12) or Live View. 

When you reload your page you see a fairly dramatic 

change. The accordion is now alongside the table. That 

is a testament to the power of CSS. Content flows 

through a Web page like water in a stream. Normally 

block elements like paragraphs, headings and tables 

disrupt that flow, acting like a damn. All content before 

block elements stays before them and content coming 

after block level elements occupy the space below them. 

By styling the table to float left it is as if the table grabs 

onto the left side of its container and allows the other 

content to swim in the water next to it. Now the “Record 

x of x” paragraph, as well as the accordion panels, are 

able to flow in the space next to the table rather than 

being pushed downstream below it. 
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Padding and Positioning the Accordion Panels 

Now that you have the accordion panels in the right area of the page you can make final adjustments to their display. Let’s begin by 

giving appropriate labels to the accordion panel tabs and making them more prominent. 

1. Switch to code view. Locate the accordion panel. It should start around line 50. The label for the first tab is <div 

class="AccordionPanelTab">Label 1</div>. Change the text for the first panel tab from Label 1 to Details and 
change its tag from div to h3. Your code should now resemble the code listing below. 

<h3 class="AccordionPanelTab">Details</h3> 

By changing the panel tab to an h3 you take advantage of h3’s built in font size and bolding. In code view you can make that change 

easily by simply editing the tag. If you make the change in design view Dreamweaver wraps an h3 tag around the label inside the div. 

This method puts too much space in the tab. I encourage you to test it out both ways and observe the results. 

2. Repeat these steps for the second tab. Change Label 2 to Image and change the tag from div to h3. Save profiles.html 
and view your changes. 

The remaining display modifications will be made to the style sheets. The accordion panels have their own CSS file, but you can 

access it easily through the CSS panel while you have profiles.html open. Note that you can quickly access the CSS files themselves 

through Dreamweaver CS4’s new Related Files Toolbar. All linked or included files are listed across the top of your file’s window 

and can be quickly accessed by clicking their names.  

The vertically-aligned images used for countries like France and Thailand force a scrollbar in the panel. You can remedy this by 

making the panels’ content cell taller. 

3. Open the CSS panel and scroll to the bottom of the list of selectors where the styles from SpryAccordion.css are 
displayed. Single-click on .AccordionPanelContent. Its properties will be displayed in the Properties pane under the 
selectors list. Change the height attribute from 200 to 270. 

If you double-click on a selector it will open its full editing window. This quick shortcut is handy, especially if the property already 

exists and you simply want to modify it. 

Currently the content in the accordion panels rests against the sides of its panels. As we learned earlier, when you want to create white 

space on the inside of a container you use padding. Padding, like margin and border, is applied either as one value to the entire box or 

four values, representing each side of the box, starting at the top and moving clockwise around the element. In order to move the 

content off of the sides of the panel you can add padding to the left and right. There is no need to add any padding to the top or bottom 

as the elements inside the panels are all inside of <p> tags, block elements with built-in top and bottom margins that set them off from 

neighboring elements above and below. 

4. Staying in the Properties pane at the bottom of the CSS panel, place your cursor after the padding value 0px, press the 
spacebar and then add 5px 0px 5px. The final value should read 0px 5px 0px 5px. 
Press Enter/Return or tab out of the field to make the change.  

 

If you look at the .AccordionPanelContent class in SpryAccordion.css, around line 70, you will 

see padding: 0px 5px 0px 5px; listed among its properties. This form of CSS shorthand is 

the effective equivalent of the following: 

padding-top: 0px; 

padding-right: 5px; 

padding-bottom: 0px; 

padding-left: 5px; 

Your final change to the page is to bring the colors of the panel tabs in line with the rest of the 

design. You can make these changes using the handy shortcut you learned in the previous steps 
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or the traditional way by double-clicking and opening the edit window. I leave the choice up to you. 

5. Locate the .AccordionFocused .AccordionPanelTab selector. Change its background color to #FFFF99. Next locate the 
.AccordionFocused .AccordionPanelOpen .AccordionPanelTab selector and change its color to #FFCC33. 

These two selectors are considered advanced selectors. They reflect the relationship of elements much like the padding you added to 

the td that was a descendant of the countryTable earlier in the class. The first is for an element with the class AccordionPanelTab that 

is a descendent of an element with the class AccordionFocused. If you look in your code you will not see any element with the 

AccordionFocused class. Spry dynamically adds that class to the main accordion div when you click anywhere on the accordion. 

The second advanced selector reflects yet another layer of ancestry, again with Spry dynamically adding the AccordionFocused and 

AccordionPanelOpen classes to the elements based on the user’s mouse clicks. Nice functionality. Aren’t you glad Spry has written it 

for you?  It has saved quite a bit of time. 

Note: In my testing, the Live View and Live Code did not show the AccordianFocused class or the results of these last changes. They 

are reflected in the final product in your browser. 

6. Save your changes and press F12 to preview. Make sure to save SpryAccordion.css as well as profiles.html.  

  

 

You have created a dynamic application for displaying the country profiles that not only provides your users with the information they 

need to learn about the countries your client’s tours visit, but you did so in a way that provided a richer experience for the users. We 
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will revisit Spry later in the book and I encourage you to keep an eye on the Spry development team’s future releases on 

http://labs.adobe.com/.  

What You Have Learned 

In this class, you have: 

•   Used the Adobe Spry library to convert data into dynamic content 

• Created a compact layout using Spry user interface elements to display a country profile  

• Used CSS to position page elements and style Spry elements with advanced custom selectors 

Additional Spry Functionality in Dreamweaver CS4 

The Spry framework has a great many effects, functional widgets and data options. Not all of them are available through 

Dreamweaver’s insert menus, but you can use any of them in the pages you build. Time permitting we will look at some of the other 

built in features together. 

Spry Validation 

Validation widgets are form elements that give the user feedback, positive or negative, to indicate whether they have entered text 

according to the correct pattern, selected the appropriate element or neglected a required field. Dreamweaver CS4 includes a number 

of Spry validation elements that will make your coding task much simpler. Before creating some of your own Spry validation 

elements, take a look at the range of options available to you. 

1. Open the Spry Demos page (http://labs.adobe.com/technologies/spry/demos/index.html) in your web browser. Click on 
Validation Widgets. 

This page displays the validation elements available in Spry and available to you through the Dreamweaver insert menu. 

2. Before entering any data, click the Submit button at the bottom of the form. 

The form validation functionality is immediately apparent. Spend a moment filling in the fields and fulfilling the form requirements. 

3. Click the View Source link at the top of the page. 

The areas of HTML that contain Spry code are highlighted in yellow. Scroll through the code looking at the validation code. Even if 

you do not write HTML, it is not difficult to understand the code it has written and to see how you might modify it. 

4. Return to Dreamweaver. Click File > New… and create a blank HTML page with no layout. Save the file as 
validationTest.html. 

Now it is time to play with the validation elements. We will insert one Spry form element and set up its validation and then you will 

have time to add more. 

5. Click Insert > Spry > Spry Validation Text Field. Set the element’s ID to participantEmail and the label to Email Address. 
Leave the other default choices and click OK. If prompted, agree to adding a form tag. 

You have added a form and text input field to the page. The code Dreamweaver has written does not have the kind of obvious Spry 

attributes used earlier in the class. At the bottom of the document you will see a small amount of JavaScript code that activates the 

validation. The Spry JavaScript and CSS files for the text field validation will be added to your site folder when you save the file.  

6. Save your file, agreeing to copy the Spry files to your site. Examine your options for configuring the validation widget in 

the property inspector. If necessary, choose <span#sprytextfield1> in the tag inspector to activate the appropriate 

property. 

The property inspector gives you a number of options. The Type list gives you a variety of “masks” that the user input must validate 

against. If you choose a type like Date, the Format drop-down gives you the specific pattern the user must match. Some types give you 

the option of a custom format. In those cases you fill in a the pattern the input must conform to in the Pattern field. In order to display 

default text in the input field that will disappear when the user clicks in the field, enter that in the Hint field. By default the validation 
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will take place when the user attempts to submit the form. In order to trigger the validation when the user clicks or tabs out of the 

field, check Blur from the Validate on list. The Preview states drop-down allows you to see the various states that the user will see. 

You must be in Split or Design view in order to see the effect. 

7. Set the type for this field to email address and choose to validate on blur. Add a hint if you would like. 

Before moving on preview the various states you have created by toggling the preview states in the property inspector. If you would 

like to change the text presented to the user for required or invalid input feedback, you may do so by editing the text in the preview 

state or in code view. 

Before saving and testing your changes you should add a submit button to the form.  

8. With your preview state set to initial, insert your cursor after your text field and press Enter to add a blank line. Click 
Insert > Form > Button. If you are presented with the choice of which kind of button, choose submit. Set its ID to submit as 
well. Save your changes, click F12 to open the page in your browser and test your work. 

Take some time to add other validation fields. Test out the drop-down (select), radio group, checkbox, textarea, etc. With each 

addition Dreamweaver will add links to the appropriate files to your document and when you save you will be prompted to place 

copies in your directory. 

Spry Widgets 

In addition to the validation effects for traditional form elements, Dreamweaver CS4 also includes a number of visual design widgets 

for your convenience. We have already seen the Spry Table and Spry Accordion. Dreamweaver CS4 also includes these other visual 

widgets: 

Menu Bar - A Menu Bar widget is a set of navigational menu buttons that display submenus when a site visitor hovers over one of the 

buttons. Menu Bars let you display a large amount of navigational information in a compact space, and also give visitors to the site a 

sense of what is available on the site without having to browse it extensively. 

Tabbed Panel - A Tabbed Panels widget is a set of panels that can store content in a compact space. Site viewers hide or reveal the 

content stored in the Tabbed Panels by clicking the tab of the panel they want to access. The panels of the widget open accordingly as 

the visitor clicks different tabs. In a Tabbed Panels widget, only one content panel is open at a given time. 

Collapsible Panels - A Collapsible Panel widget is a panel that can store content in a compact space. Users hide or reveal the content 

stored in the Collapsible Panel by clicking the tab of the widget. 

Tooltip - The Spry tooltip widget displays additional information when a user hovers over a particular element on a web page. The 

additional content disappears when the user stops hovering. You can also set tooltips to stay open for longer periods of time so that 

users can interact with content inside the tooltip. 

There will not be time in this class to test each of these but you are encouraged to do so. Documentation of how to use each in 

Dreamweaver is available in the help files at http://help.adobe.com/en_US/Dreamweaver/10.0_Using/index.html. Full Spry 

documentation is listed in the resource section that follows. 

Additional Resources 

This class has just brushed the surface of the wonderful power of both Dreamweaver CS4 and the Spry Ajax Framework. Below are a 

few resources that will help reinforce what you have learned here and lay a path for you to take your learning further. 

Spry Homepage - http://labs.adobe.com/technologies/spry/home.html 

Spry Resources on Adobe Devnet - http://www.adobe.com/devnet/spry/  

Creating an HTML data set for Spry in Dreamweaver - 

http://www.adobe.com/devnet/dreamweaver/articles/spry_creating_html_data_set.html 

Creating an XML data set for Spry in Dreamweaver - 

http://www.adobe.com/devnet/dreamweaver/articles/spry_creating_xml_data_set.html 

Creating a Spry photo album in Dreamweaver - http://www.adobe.com/devnet/dreamweaver/articles/spry_photo_album.html 

 


